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Introduction 

 
About SynerJY® 

SynerJY® is a complete integrated data-acquisition and -analysis 
software package for HORIBA Scientific spectroscopic systems. 

  
Note: Keep this and the other reference manuals 
near the system. 



User’s Guide for SynerJY® Software Version 3 rev. 1 (20 Jul 2009) Introduction 

v 

Disclaimer 
By setting-up or starting to use any HORIBA Jobin Yvon product, 
you are accepting the following terms: You are responsible for 
understanding the information contained in this document. You 
should not rely on this information as absolute or all-
encompassing; there may be local issues (in your environment) not 
addressed in this document that you may need to address, and there 
may be issues or procedures discussed that may not apply to your 
situation. If you do not follow the instructions or procedures 
contained in this document, you are responsible for yourself and 
your actions and all resulting consequences. If you rely on the 
information contained in this document, you are responsible for: 
• Adhering to safety procedures 
• Following all precautions 
• Referring to additional safety documentation, such as Material 

Safety Data Sheets (MSDS), when advised 
 
As a condition of purchase, you agree to use safe operating 
procedures in the use of all products supplied by HORIBA Jobin 
Yvon, including those specified in the MSDS provided with any 
chemicals and all warning and cautionary notices, and to use all 
safety devices and guards when operating equipment. You agree to 
indemnify and hold HORIBA Jobin Yvon harmless from any 
liability or obligation arising from your use or misuse of any such 
products, including, without limitation, to persons injured directly 
or indirectly in connection with your use or operation of the 
products. The foregoing indemnification shall in no event be 
deemed to have expanded HORIBA Jobin Yvon’s liability for the 
products. 
 
HORIBA Jobin Yvon products are not intended for any general 
cosmetic, drug, food, or household application, but may be used 
for analytical measurements or research in these fields, or for 
forensic applications. A condition of HORIBA Jobin Yvon’s 
acceptance of a purchase order is that only qualified individuals, 
trained and familiar with procedures suitable for the products 
ordered, will handle them. Training and maintenance procedures 
may be purchased from HORIBA Jobin Yvon at an additional cost. 
HORIBA Jobin Yvon cannot be held responsible for actions your 
employer or contractor may take without proper training. 
 
Due to HORIBA Jobin Yvon’s efforts to continuously improve our 
products, all specifications, dimensions, internal workings, and 
operating procedures are subject to change without notice. All 
specifications and measurements are approximate, based on a 
standard configuration; results may vary with the application and 
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environment. Any software manufactured by HORIBA Jobin Yvon 
is also under constant development and subject to change without 
notice. 
 
Any warranties and remedies with respect to our products are 
limited to those provided in writing as to a particular product. In no 
event shall HORIBA Jobin Yvon be held liable for any special, 
incidental, indirect or consequential damages of any kind, or any 
damages whatsoever resulting from loss of use, loss of data, or loss 
of profits, arising out of or in connection with our products or the 
use or possession thereof. HORIBA Jobin Yvon is also in no event 
liable for damages on any theory of liability arising out of, or in 
connection with, the use or performance of our hardware or 
software, regardless of whether you have been advised of the 
possibility of damage. 
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Symbols used in this guide 
Certain symbols are used throughout the text for special conditions 
when operating the instruments: 
 

General information is given concerning 
operation of the equipment. 

   Note: 
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Note: SynerJY does not work with an original 
SpectraLink Controller. 

1: Installation 
Requirements 

To successfully install SynerJY®, your host computer needs the 
following: 

Software 
Windows® 2000, Windows® XP, or Windows® Vista 32 

Hardware 
• 512 MB RAM (1 GB recommended) 
• 1 GB hard-disk space 
• One available USB port for SynerJY® hardware key  
• Video resolution of at least 1024 × 768 
• CD-ROM drive 

Supported instruments 
• All TRIAX, Gemini, M Series, FHR640/1000, HR460, H10, 

H20, all SPEX232/488 compatible spectrometers, and CP Se-
ries;1000M Series II and 1250M Series II; Micro-HR (manual 
and automated); iHR320 and iHR550 spectrometers 

• VS140 fiber-optic-based spectrograph  
• HR640 and THR1000 spectrometers (requires HR Link Con-

troller)  

• Symphony array detectors with auxiliary input support; syn-
apse array detectors with auxiliary input support (latest firm-
ware required) 

• CCD-3000, CCD-3500, and IGA-3000 family of array detec-
tors  

• DataScan2 and SpectrAcq2 data-acquisition systems  
• Lock-in amplifiers: SR510, SR530, with RS-232 communica-

tion only 
• Lock-in amplifiers: SR810, SR830, SR850, and EG&G 

7260/Signal Recovery 7265 GPIB and RS-232 communication   
• HJY and Jobin Yvon filter-wheels, internal and external 
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Installation and startup overview 
The installation of your HORIBA Scientific spectrometer and 
SynerJY® software has several separate stages that must be 
completed for the system to operate properly. Please follow the 
steps in the order listed below for proper installation and startup. 

1 Set up all equipment and connect all 
cables. 

2 If your system contains a CCD or In-
GaAs Array, follow the “Installation of 
CCD Hardware Files” procedure (page 
3) before installing SynerJY®. 
If your system does not include a CCD or InGaAs Array, 
please start with step 3. 

3 Install SynerJY® according to the proce-
dure listed on page 5. 

4 Following installation, set up SynerJY® 
software for your specific system confi-
guration. 
The copy of SynerJY® shipped with your system contains a 
preset configuration that needs to be loaded. If you received 
SynerJY® as a stand-alone copy with no preset configuration, 
you can create your hardware configuration using the proce-
dure in the next chapter. 

5 If your system includes a CCD, perform 
the “CCD Focus and Alignment” proce-
dure (see SynerJY Help>Experiment 
Setup>General Parame-
ters>Detectors>Multi-channel Detector 
Parameters>CCD Focus and Align-
ment). 

6 Perform the “Monochromator Calibra-
tion” procedure (see SynerJY 
Help>Experiment Setup>General Para-
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 detector, 

a-
>Detectors>Multi-channel Detec-

 conversion of the CCD detector. Before running 
 

8 You are ready to enter your experiment 
parameters and begin acquiring data.  

meters>Monochromators >Monochro-
mator Calibration). 
This procedure serves as an initial check, prior to running an 
experiment, that your system's monochromator is properly ca-
librated and aligned. 

7 If your system includes a CCD
perform the “CCD Wavelength Calibra-
tion” procedure (see SynerJY 
Help>Experiment Setup>General Par
meters
tor Parameters>Wavelength Calibra-
tion). 
This procedure is a method of calibrating the pixel-to-
wavelength
this procedure, the CCD detector must be focused and aligned,
and the monochromator center-wavelength must be properly 
calibrated. 
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Note: If you have a Synapse™ detector, skip this step. 

Step 1: Connect all components and 
cables. 

Follow the instructions supplied with the components. 

Step 2: Install CCD hardware files 

Introduction 
HORIBA Scientific spectrometers can be integrated with various 
detectors and accessories, which can be added or removed from the 
hardware configuration for a variety of experiment types. 
Hardware configurations with CCD detectors require the 
installation of CCD files before creating or loading a hardware 
configuration . We recommend that you install these files prior to 
installing SynerJY®. CCD hardware files are on the Initialization 
and Setup CD or disk with your CCD. The following procedures 
are for Symphony®-based systems. If you do not have a CCD, 
continue with the “Installing SynerJY®” section (page 5).  

Installation of Symphony® CCD hardware files 

1 Start Windows® if necessary. 
Make sure all programs are closed. 

2 Insert the CD labeled “Symphony” into 
the CD-ROM drive. 
If Autorun is enabled, installation begins automatically. If Au-
torun is not enabled, execute the Setup.exe file by select-
ing My Computer>Symphony CD-ROM>Setup.exe.  
 
The InstallShield Wizard window appears. 

3 Click the Next > button. 
The License Agreement area appears. 

4 Read the License Agreement carefully, 
then click the Yes button. 
You must agree in order to install the Symphony® hardware 
files. 
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Note: A dedicated 10/100 Ethernet port must 
be installed in your PC prior to configuring the 
IP connection. If you are connected to a Local 
Area Network (LAN), installation of a second 

ymphony® manual 

 a destination location, or click the 
-

ing in the last number set of the 
Symphony® IP Address. 
The default value is 2, but you may enter any number from 2 
to 255. 

y. 
 Symphony® has been suc-

utton. 
ove the Symphony CD from the 

CD-ROM drive. 
 
  

  

port is required. See the S
for Ethernet NIC installation instructions. 

5 Enter your name and the name of your 
company. Click the Next > button. 

6 Select
Next > button to accept the default loca
tion.  

7 Review the current settings, then click 
the Next > button to continue. 

8 Configure the Network Interface Card 
(NIC) Internet Protocol (IP) connection 
by typ

9 Click Set as Symphon
A message appears indicating that
cessfully configured. 

10 Click the OK button. 
11 Click the Finish b
12 Rem
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Note: When the Symphony® controller is 
switched on and the network settings are ac-
tivated, the system-status LEDs on the front 
panel of the controller blink at 1 Hz, indicating 
that the Symphony® CCD detection system is 
awaiting initialization. To initialize and load or 
create a hardware configuration with a Sym-
phony® CCD detector, the Symphony® hard-
ware files must be installed. 

Note: Do not launch SynerJY® until the Sym-
phony® controller LEDs stop blinking. 
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Note: You must be an Windows® administrator in order to 
install SynerJY®. 

Step 3: Install SynerJY® 

1 Remove any HORIBA USB software key 
(if inserted) from the host computer be-
fore starting the installation. 

®2 Insert the SynerJY  CD-ROM in the host 
computer’s CD-ROM drive. 

3 If Autorun is not operating, continue 
here: 
If Autorun is operating, continue with step 4. 

a On the desktop, open the My Computer 
icon.  

b The My Computer window opens: 

 
c Click on the CD-ROM drive to open the SynerJY® CD-

ROM. 
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tinue here, to 
re: 

The InstallShield® Wizard starts. 

 
a 

The License Agreement appears. 

d Click the Setup.exe icon. 

 
e Continue with step 4 below. 

4 If Autorun is operating, con
install SynerJY® softwa

Click the Next > button. 
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es. 

d 
The Choose Destination Location area appears. 

 
b Click I accept the terms of the license agreement 

radio button, then the Next > button. 

The Customer Information area appears. 

  
c ompany Name. Enter your User Name and C

The Next > button activat

Click the Next > button. 
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g 

 
to the hard-drive, and the Setup Status area appears: 

  
e Choose the location where SynerJY® is to be installed. 

Most people prefer the default location. Click the 
different location. Change button to find a 

f Click the Next > button. 

The Ready to Install the Program area appears: 

Click the Install button. 

The computer starts copying the files from the CD-ROM
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End User License Agreement

  
Eventually the Horiba Jobin Yvon USB Installer window 
appears. 

5 Install the USB device. 

 
a Click the Next > button. 

The  area appears: 
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c 
ftware for your HJY USB de-

vice... area appears. 

 
b Click the I accept this EULA radio button, then click the 

Next > button. 

A Software Installation warning window may appear: 

 
Click the Continue Anyway button. 

The Installing the so
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When complete, the Congratulations! You are finished 
installing your HJY USB device. area appears: 

 
d Click the Finish button. 

The Horiba Jobin Yvon USB Installer window closes. The 
InstallShield Wizard Complete area appears. 
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6 Click the Finish button. 
Installation of SynerJY® is complete. 

7 Plug in all HORIBA software keys. Re-
move the SynerJY® CD-ROM from the 
host computer.  

Note: You must insert the SynerJY® hardware 
key into a free USB port to start SynerJY®. 

Step 4: Focus and align CCD 
Follow the instructions supplied with the components. 

Step 5: Calibrate monochromator 
Follow the instructions supplied with the components. 

Step 6: Calibrate CCD wavelength 
Follow the instructions supplied with the components. 
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Note: All new systems have a hardware configuration al-
ready on the SynerJY® installation disk. 

2: Creating and Loading 
Configurations 

Loading a pre-existing hardware con-
figuration 

Your SynerJY® CD contains a hardware-configuration template 
that is custom-designed for your system. Your hardware 
configuration can be loaded automatically from this file.  

1 On the Windows® desktop, 
click the SynerJY V3 shortcut 
to start SynerJY®. 
Be sure the SynerJY® hardware key is inserted in a free USB 
port of your computer. 

 

2 In the SynerJY toolbar, click the Pre-

vious Experiment Setup button . 
The Select Configuration window appears.  
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3 In the list, 
double-click 
the configura-
tion you de-
sire. 
The hardware confi-
guration loads. 
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Creating a new hardware configura-
tion 

1 On the Windows® desktop, 
click the SynerJY V3 shortcut 
to start SynerJY®. 
Be sure the SynerJY® hardware key is inserted in a free USB 
port of your computer. 

2 The SynerJY main window appears. 

 

3 In the SynerJY toolbar, click the Pre-

vious Experiment Setup button . 
The Select Configura-
tion window appears.  

4 Click the New 
utton. b

 
 
 
 
 
 
 
 
 
 

 The System Configuration Wizard opens.

5 reate the configuration. C
 



User’s Guide for SynerJY® Software Version 3 rev. 1 (20 Jul 2009) Creating & Loading Configurations 

18 

 
 

 
a Select the Detailed Component Configuration radio 

button, then click the Next >> button. 

The Device Configuration window appears. 

b Choose a device type, then click the Next > button. 
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Note: For multichannel detectors, e.g., Syn-
apse™, choose HJY USB from the Special 
Types drop-down menu.

c Select the specific type of device (spectrometer model, 
detector type, etc.), then click the Next > button. 

 

d Enter all Communications Parameters for the device, 

 

then click the Next > button.  
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ither enter 

lti-channel 

 
A summary of the device configuration appears. 

e Enter the Device Display Name (the device’s model 
name appears as the default), then click the Next > 
button. 

 
f Depending on the device type being added

the device’s Accessory information (for 
monochromator), Filter Wheel Information (for 
accessory) or CCD Table Path (for mu

, e

detector), then click the Next > button. 
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h 

nd until you have 

When all additions are entered, click the Cancel button to 
exit the Device Configuration window. 

 
g If the hardware is attached to the host computer and 

switched on, click the Validate Hardware button to 
verify that the host computer communicates with this 
device. 

Click the Finish button to continue. 

The Device Configuration window reappears.  

i Repeat steps b–h for your detector, a
added all of your system’s devices. 

 
j 
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A Warning wi
dow appears. 

n-

m 
d 

k Click the Yes 
button. 

The New Confi-
guration window opens: 

6 Enter the 
ConfigID (a 
descriptive 
label, for ex-
ample, Mi-
croHR + 

n. Symphony), then click the OK butto
 Configuration window appears.  The Select Hardware

7 Choose the 
new config-
uration fro
the list, an
click the 
Edit button. 
 
 
 
 
 
The System Con-
figuration window 
appears. 

8 Attach the devices to this hardware con-
figuration: 
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e 
 closes. The Select 

Hardware Configuration window appears, with the newly 
created hardware configuration.  

 

a Click on a desired device in the appropriate tab.  

Each device appears in the Available Devices list when 
the appropriate tab is selected (see “Table of all devices, 
and tabs under which they appear”). 

b Click the >> button to add it to the configuration. 

c The device appears on the graphic in the top area of the 

er various tabs until the 

System Configuration window. 

d Continue adding devices und
configuration is complete. 

Click the OK button. 

The System Configuration window
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Note: With a manual instrument (such as a 
manual MicroHR) or instrument with a single 
removable grating (such as an M-series), 
create a separate device configuration when-
ever you use a different grating. For example, 
if you are using both a 1200 grooves/mm 
grating and 1800 grooves/mm grating with a 
1000M, you need to create one configuration 
for the 1000M-1200 and one for the 1000M-
1800. Even if all of the detectors and acces-
sories are the same, you still must create two 
device configurations for the monochromator. 
Create separate device configurations for in-
struments having multiple turrets: one device 
configuration for each grating on a turret. 

9 Select the 
desired 
configura-
tion and 
click the O
button. 

K 
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Editing an existing hardware configu-
ration 

Any changes made to the system's hardware configuration must be 
reflected in the SynerJY® System Configuration to establish proper 
communications. There are three ways to edit the System 
Configuration: 
• Remove a device from the hardware configuration 
• Add an available device to the hardware configuration 
• Add a new device to the hardware configuration 

Remove a device from an existing hardware 
configuration 

1 Start SynerJY® as explained in earlier 
sections of this chapter. 

2 Select Collect>Experiment Setup.  
The Select Hardware Configuration window opens. 

3 Select the 
desired 
configura-
tion, and 
click the 
Edit but-
ton. 
 
 
 
The System 
Configuration 
window ap-
pears. 

4 Edit the 
configuration: 
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splay a visual representation 
of the system configuration. 

 

 

a If you are not changing the overall system layout (such as 
from “1 mono, 1 detector” to “1 mono, 2 detectors,” etc.) 
proceed to Step b. If you are changing the system layout, 
select the Clear button in the System Setup area, then 
choose the appropriate Layout from the dropdown menu 
that appears on the right: 

 

b Click the Create button to di
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c To remove a device from the configuration, select the tab 
containing the type of device you want to remove, and 
click the << button. 

 
 Before removal  After removal 
 
The device is no longer viewable in System Setup. 

Add an available device to an existing hard-
ware configuration 

1 Start SynerJY® as explained earlier in 
this chapter. 

2 Experiment Setup. Select Collect>
The Select Hardwa

Select th
re Configuration window opens: 

3 

he System Configu-

e de-
sired configu-
ration to edit, 
and click the 
Edit button. 
 
 
 
 
 
T
ration window opens. 

4 Edit the hardware configuration: 
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lay a visual representation 
of the system configuration.  

 

a If you are not changing the overall system layout (such as 
from “1 mono, 1 detector” to “1 mono, 2 detectors,” etc.) 
proceed to step 6. If you are changing the system layout, 
select the Clear button in the System Setup area and 
choose the appropriate Layout from the drop-down menu 
that appears on the right. 

 

b Click the Create button to disp
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c To add a device that has already been configured, select 
the tab containing the type of device that you want to add, 
and select the device from the list of Available Devices. 

d Click the >> button. 

The device is now viewable in System Setup. 

Add a new device to the hardware configura-
tion 

1 Start SynerJY® as explained earlier in 

2 
re Configuration window opens.  

t 

 Edit
utton. 

u-

4 Edit the hardware configuration. 

this chapter. 
Select Collect>Experiment Setup.  
The Select Hardwa

3 Select the 
configuration 
that you wan
to edit, and 
click the  
b
 
 
 
The System Config
ration window ap-
pears. 
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lay a visual representation 
of the system configuration.  

ting & Lo

 

a If you are not changing the overall system layout (such as 
from “1 mono, 1 detector” to “1 mono, 2 detectors,” etc.) 
proceed to Step 6. If you are changing the system layout, 
select the Clear button in the System Setup area, then 
choose the appropriate Layout from the drop-down menu 
that appears on the right. 

 

b Click the Create button to disp
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Note: For multichannel detectors, e.g., 
Synapse™, choose HJY USB from the 
Special Types drop-down menu.

 

or 
type, etc.) of device, then click the Next > button. 

arameters for the device, 

 

me appears 

, 
heel Information (for accessory) or CCD Table 

Path (for multi-channel detector), then click the Next > 
button. 

c Remove any devices from the configuration that are no 
longer going to be included in your system, via the << 
button.  

d To add a device, select the tab containing the type of
device you want to add, then click the Add button.  

e Select the specific type (spectrometer model, detect

f Enter all Communications P
then click the Next > button. 

g Enter a Device Display Name (the model na
as the default), then click the Next > button. 

h Depending on the device type being added, either enter 
the device Accessory Information (for monochromator)
Filter W
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i Select the tab containing the device that you just added, 
and select the device from the list of Available Devices 
(see “Table of all devices and tabs under which they 
appear,” page 49).  

j Click the >> button to add the device to the hardware 

ration name in the 

iguration that you just edited appears in the 
uration window.  

button.  
 

configuration.  

k Type the updated configu
Configuration text box. 

l Click the Apply button, then click the OK button. 

The hardware conf
Select Hardware Config

5 Select the 
hardware con-
figuration, then
click the OK
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Table of all devices*, and tabs under 
which they appear 

Detectors tab Detector subtype 
Multichannel Symphony  

CCD3000 IGA3000 (GPIB = 6 checkbox is 
active) 
Standard (checkbox is inactive) 

HJY USB Sygnature/VS140 
Synapse 

Single-channel Lockin Stanford Research 
EG&G 

Symphony Aux Voltage radio button 
Current radio button 

SpectrAcq2 Voltage radio button 
Current radio button 
Photon radio button 

DataScan Voltage radio button 
Current radio button 

Synapse Aux Voltage radio button 
Current radio button 

Monos tab 
1000M 
1250M 
1269 
1680 
1681 
1702 
1704 
1704 
1870B 
1870C 
1877 
270M 
340E 
340S 
500M 
750M 
750S 
CP140 
CP200 
DH10 
FHR1000 
FHR640 
Gemini 180 
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H10 
H20 
HR1000 
HR1500 
HR460 
HR640 
iHR320 
MicroHR Automated 
MicroHR Manual 
THR1000 
Triax180 
Triax190 
Triax320 
Triax550 
Accessories tab Filter Wheel 

Controller 
Filter Wheel 
Controller model 

Filter  Wheel 
type 

 
Filter Wheel 
(currently the only 
OSD accessory) 

Default  JY 6 
position 

JY SAS 5 
Position 

MicroHR 5 
Position 

DataScan  
Triax  
MSD  
HJY USB 
 

MicroHR 
iHRSeries 

*Device list is subject to change. 
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Note: The SynerJY® hardware USB key must 
be installed in order to run experiments. The 
USB key may be inserted after installing 
SynerJY®.

3: Running SynerJY® 
Starting SynerJY® 

1 Insert the SynerJY® hardware key into a 
free USB port on your computer. 

2 Either click the SynerJY V3 
shortcut, or in the Windows® 
Start menu, select Programs. 
A menu appears. 

3 Choose Jobin Yvon. 
Another menu appears.

 

4 Choose SynerJY. 
The main SynerJY window opens: 
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5 Click the Previous Experiment Setup 
button ,... 

 

6 ...or in the toolbar, choose Collect, and 
from the drop-down menu select Expe-
riment Setup. 

 

7 The Hardware 
Configuration 
window 
opens. 
If you do not select a 
configuration, the de-
fault setup will run au-
tomatically. 
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8 Choose a hardware configuration, and 
click the OK button. 
The System Initialization Process window opens: 

 

9 Click the Next>> button when it ap-
pears. 
After successful hardware initialization, the Experiment Setup 
window appears. 
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Special SynerJY® buttons 
In the main SynerJY window’s toolbar, there are seven special 
buttons for running experiments in SynerJY®: 
 

 
 

 
 
Previous Experiment 
button   

Modify slightly a previously set-
up experiment, and run it. 

Auto Run Previous 
Experiment button  

 Run a previously set-up 
experiment without 
modification. 

Run JY Batch 
Experiments button  

Run an automated series of 
experiments, including 
adjustable repeats and delays 
between experiments. 

Real Time Control 
button  

Open the Real Time Control 
window directly, to adjust 
experimental parameters in real 
time. 

Make Overlay File 
button  

With an existing graph selected, 
create an .SPC file for use as an 
overlay file. The existing graph 
should contain a single 
spectrum. 

3D Scan to 3D Profile 
button  

Extract excitation and emission 
profiles from an excitation-
emission matrix. The active file 
must be such a data matrix. 

Switch menu 
between HJY 
Software Application 
and Origin Std. button 

 
Switches the menus at the top of 
the main SynerJY window 
between SynerJY® and Origin® 
functions. 

 
From many of these buttons, upon initial start-up of the software, 
you can choose a hardware configuration. After a hardware 
configuration is loaded, each button has its own separate function.
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Quick start to run an experiment 
To run an experiment, first you must load or create your hardware 
configuration. We strongly recommend that you perform the 
appropriate instrument calibration procedures (see “Installation and 
Startup Overview: Initial System Setup,” page 1) before collecting 
data with your system. See the Help file for information about 
configuring hardware, entering experiment parameters, saving 
data, types of experiments, correction techniques, and data-
processing and -analysis. 

1 Click the SynerJY V3 short-
cut, or in the Windows® Start 
menu, select Programs>Jobin 
Yvon>SynerJY. 
The SynerJY window opens. 

2 Click the Previous Experiment Setup 
button  ,... 

 

3 ...or in the toolbar, choose Collect, and 
from the drop-down menu select Expe-
riment Setup. 

4 Choose your 
hardware con-
figuration in 
the Select 
Hardware Con-
figuration win-
dow, and click 

 the OK button. 
The Experiment Setup 
window opens. 
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Note: Make sure 
the Active box is 
selected to en-
sure that your 
detector is active.

5 Click the ... button in the Experiment File 
field to open a previously saved file, or 
click in the field and enter a file name to 
create a new file. 

 

6 If creating a new 
Experiment File, 
enter the experi-
ment parameters. 

7 Click the Run but-
ton. 
The experiment runs. When finished, the Project name win-
dow appears. 

8 Enter a Project name, or select the 
Browse button to open an existing 

 click the OK button. project, then
The data are saved 
to the project file 
you just created or 
opened.  
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Tips and Tricks 
Getting started with SynerJY® 

A full set of tutorials for the data display, analysis and 
programming for SynerJY® is provided in the Help file under 
Tutorials.  

Emulation mode 
Emulating the SynerJY® software means letting the host computer 
act as though the hardware is properly connected, even if it isn’t. 

1 Disconnect the communications cables 
from the host computer to the devices. 

2 Start SynerJY®. 
The main SynerJY window opens: 

 

3 Click the Previous Experiment Setup 
button , or in the toolbar, choose 
lect, and from the drop-down menu 
lect Experiment Setup. 
The Select Hardware Configuration window opens. 
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4 Choose the 
desired in-
strument con-
figuration you 
wish to emu-
late, then click 
the OK button.  
 
 
The System Initializa-
tion Process window 
opens: 

 
Under the Status column, warning symbols appear for the 
hardware devices, noting that they were Not Found. Thus 
SynerJY® chooses the Emulate radio button as the default ac-
tion for each device. 

5 Click the Next>> button. 
The Experiment Setup window appears. SynerJY® is now 
emulating the instrument. 
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Real Time Control 
To see the effects of adjusting experimental parameters in real 
time, SynerJY® offers the Real Time Control window. In this 
window, you can open and close shutters, adjust detectors, etc and 
view immediately the effects on signal, before you start the 
experiment. 

 

1 In the Experiment Setup window, click the 

RTC button . 
2 The Real Time Control window appears: 
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3 Adjust monochromators, spectrometers, 
detectors, and other devices as neces-
sary, in the various tabs and icons. 

4 Click on the downward arrow ↓ to en-
large the graph. 

5 Click the Cancel button  to return 
to the Experiment Setup window. 
The experimental parameters you entered are transmitted to 
the Experiment Setup window automatically. 
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Note: For greater detail about projects, graphs, 
layers, and how to merge, combine, and sepa-
rate them, see the Origin® on-line help files. 

Projects and files Projects and files 
What is a project? What is a project? 

A SynerJY® project file contains all the data worksheets, graphs, 
layout pages, and notes windows that are open in the workspace 
when you save the project. These windows include minimized and 
hidden windows. 

A SynerJY® project file contains all the data worksheets, graphs, 
layout pages, and notes windows that are open in the workspace 
when you save the project. These windows include minimized and 
hidden windows. 
  
A project is a collection of data that contains: A project is a collection of data that contains: 
• Graphs (visual diagrams of the data) • Graphs (visual diagrams of the data) 
• Worksheets (tables of data) • Worksheets (tables of data) 
• Notes (comments about the data) • Notes (comments about the data) 
  

  
  
Graphs themselves may contain multiple kinds of information, 
including separate layers describing the data, the axes, the 
background colors, etc. 

Graphs themselves may contain multiple kinds of information, 
including separate layers describing the data, the axes, the 
background colors, etc. 
  
Concerning worksheets, a dataset must contain at least two 
columns, corresponding to x-y data pairs. Multiple y columns may 
correspond to a single x column. 

Concerning worksheets, a dataset must contain at least two 
columns, corresponding to x-y data pairs. Multiple y columns may 
correspond to a single x column. 

  

Project

Graphs

Layers

Datasets Axes Backgrounds

Worksheets Notes
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Project names 
Each time you start SynerJY®, after you run a new experiment in 
the Experiment Setup window, the Project name window appears. 

 
This dialog box asks you to enter a Project name. Enter a new or 
existing project name, or select the Browse button to open an 
existing project. If you enter an existing project name, choose to 
either Append the new data to the existing project or to Overwrite 
the existing file. 
 
The name of the project (here UNTITLED) appears in the explorer 
area at the bottom left of the main SynerJY window. 

  
You are only asked to enter the Project name once. The data 
collected for each run of the experiment are saved as data sets 
(consisting of graphs, worksheets, and notes) within the project file 
folder. 
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Note: Whe  closing any of the individual windows 
within a project folder, SynerJY® asks if you want 
to Delete, Hide, or Cancel. Selecting the Delete 
button PERMANENTLY DELETES the selected 
window. Hiding the window removes it from im-
mediate view, but that window can be viewed 
again by selecting it from the project window. 

n  

 
Selecting File>Close closes the entire project 
folder and all its associated windows. 
 
See the “Creating a Project File” topic in the Help 
file to view a short demonstration about creating 
SynerJY® Project Files. 

The data graphs are shown in the root directory (here called 
UNTITLED) of the project.  The inactive files have a pale icon. 
 

 
 
The actual data worksheets and notes files are stored in the data 
sub-folder of the project. Double-click the data folder to open it. 
 

 
 
The graph, worksheet, and note file are all named with the same 
base-file name. The graph has only the base-file name and a 
number. The data worksheet has the base-file name plus a d (to 
indicate a data file) and a number.  The notes file has the base-file 
name plus an n (to indicate a notes file) and a number. 
 
You can create new folders, rename them, and move files around 
as you wish. 
 
To rename the project, either right-click on the project name and 
select Save Project As, or select File>Save Project As. 
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Combining two plots (datasets) into one graph 
In its upper left corner, an open graph has a small box with a 
number in it. 

 
1 Right-click on the numbered box in the up-

per left corner of the graph. 
A drop-down menu appears. 

 
2 Choose Layer Contents.... 

The Layer Number window opens. In the Available Data column, 
a list of x-y data available to plot is shown: 
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Note: For datasets with multiple y columns with 
one x column, the first y column plus the x col-
umn is listed as ***_a, and the second y col-
umn plus the x column is listed as *** b, etc. 

3 Click on the x-y dataset you wish to add to 
the plot. 

 

4 Choose the => button to add this dataset to 
the plot. 
The dataset appears in the Layer Contents column. 

5 Adjust its order (top to bottom) with the ↑ 
and ↓ buttons. 

6 Click the OK button to cause the dataset to 
appear in the graph. 
The Layer Number window closes. 
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Note: Each layer has 
its own number in the 
upper left corner. 

Merging two or more graph windows 
This puts all the open layers on one single page. 

1 Close all graph windows you don’t want to 
merge. 
In the Project Explorer at the bottom of the main SynerJY 
window, double-click on the names of the undesired open graphs. 
These graphs close. 

 
2 Click the Merge button . 

All the windows are combined onto one sheet of paper. This is 
called a “graph”. To preserve the old graphs while creating a new, 
overlaid version, answer Yes to the question, “Do you wish to 
keep the old graphs?” 

3 A window ap-
pears asking you 
for numbers of 
rows and col-
umns.  
To exactly overlay the 
graphs, choose 1 row and 1 
column. 
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Note: Other buttons available using the Customize 
Toolbar command are the button for splitting each 
layer into a separate graph window, and the but-
ton for merging all open graph windows into one 
graph. See the Origin® on-line help for more in-
formation. 

Splitting two graphs by extraction 
This extracts each plot to a separate layer in the graph. 

1 Click on the desired plot to activate it. 
2 In the toolbar, choose the Extract to Layers 

button . 
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Note: To determine if you are in an untitled, new 
experiment, examine the path shown at the top of 
the main SynerJY window. It should show the word 
“UNTITLED” at the end of the path. 

Note: If you are using an existing project name, 
the software will allow you to overwrite existing 
data, or append the new data to the project. 

Saving and recalling a file 

To save a project, when in a new, untitled 
project 

1 Run an experiment. 
When the experiment is complete, the Intermediate Display 
disappears. The Project Name window appears. 

2 Enter a 
new name 
for the 
project, or 
browse for 
an existing one. 

3 Click the OK button. 
The path of the project appears at the top of the main SynerJY 
window. The data are now saved. 

To save data into a new project when another 
project is already open 

1 Run the experiment. 
2 Choose File. 

 
The File menu opens: 
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Note: Only a Graph or a Matrix lets you pick a 
new Path and Name. 

3 Choose New.... 
The New window opens: 

 
4 Choose Project from the list of 

objects to create, then click the 
OK button. 

The data are now in an untitled project. Next 
you must create the name for the file. 

5 Choose File again.  
The File menu opens. 

6 Choose Save Project As.... 
The Save As window appears: 
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7 In the File name field, enter a name. In the 
ose Project (*.opj) 

e. 

1 
The Fil ns. 

2 
The Open  appears:

3 ect, or examine 
the Recent Projects list. 

4 Click the Open button. 
The project opens. 

Save as type field, cho
from the list. 

8 Click the Save button. 
Now the project has a new nam

 To recall and open an existing project 

 

Click File. 
e menu ope

Choose Open.... 
 window

Browse for the desired proj
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4: Shutting Down SynerJY® 
1 Save experiment files (and data files, if 

created). 
2 In the Experiment Setup window, click the 

Close button  or the Cancel button . 
3 Close the main Syn-

erJY window, using ei-
ther the Close button 

, or, in the File drop-
down menu, Exit. 

  

Note: Shut down de-
vices after shutting 
down the software. 
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5: Uninstalling SynerJY® 
1 Close SynerJY®. 
2 Click the Start button to open the Start 

menu. 

 

3 There are two ways to continue: 
a Choose Set Program Access and Defaults, or... 

b Choose Control Panel. 
The Control Panel opens: 
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Click Add or Remove Programs. 

4 In both cases, continue here. 
The Add or Remove Programs window opens. 

 

5 Click the Change or Remove Programs 
icon. 
A list of currently installed programs on the host computer 
appears: 



User’s Guide for SynerJY® Software Version 3 rev. 1.0 (20 Jul 2009) Uninstalling SynerJY® 

58 

 

6 Click HJY Application Software 3.0, 
which becomes active: 

 

7 Click the Remove button. 
8 Follow the instructions to remove Syn-

erJY®. 
The uninstall program removes program files, folders, and re-
gistry entries. The SynerJY® Data folder is not removed. 

9 You may need to reboot the host com-
puter. 
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re Versi
SynerJY® is removed from the host computer. 

10 Remove the USB key from the USB 
port. 



User’s Guide for SynerJY® Software Version 3 rev. 1.0 (20 Jul 2009) Troubleshooting & Tech. Support 

60 

6: SynerJY® 
Troubleshooting & 
Technical Support 

Troubleshooting 
If the special SynerJY® buttons are grayed-
out, 

 
1 Choose Collect. 

 
A drop-down menu appears. 

2 Choose System UI Reset. 
The buttons should become active again. 
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On-line help files 
1 In the main SynerJY window, choose the 

Help menu. 
2 Choose Data Acquisition. 

 
Context-sensitive on-line help files appear. Resize the window to 
your liking. 

 

  



User’s Guide for SynerJY® Software Version 3 rev. 1.0 (20 Jul 2009) Troubleshooting & Tech. Support 

62 

If you have a technical problem, 
1 Please consult the SynerJY® help files and 

this User’s Guide, as well as all other ma-
nuals supplied with the system. 

If you are unable to solve the problem, 

2 Note the problem and any accompanying 
error messages. 

3 Determine SynerJY®’s version number. 

a In the main SynerJY window, choose the Help menu. 

b 

 

Y 

on numbers. 

c Click the View 
System Info button. 

Choose About SynerJY.... 

 
The About SynerJ
window opens. 
Near the bottom 
are the SynerJY®

nd Origin® ver-
 

a
si
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button to close the Installe

-

rs 

ow), and be pre-

The Installed Components window appears, displaying all the 
software required for SynerJY®.

 
d Record the information by clicking the: 
• Save To File... button, which saves the information to a 

file; 
• Zip Info button, which compresses the information while 

saving it; 
• Print Info button, which prints out the software informa-

tion. 

e Click the OK d Components 
window. 

f Click the OK button to close the About SynerJY window. 

4 Write down the software and system infor
mation, including version number, along 
with the purchase dates, model numbers, 
system configuration, and serial numbe
of the instrument and its accessories. 

5 Please contact a HORIBA Scientific OSD 
Customer Service Representative by tele-
phone or e-mail (listed bel
pared to provide: 
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b 
evant 

ll instrument parameters (detector 
tc.) so we can assist you. 

Contact information 
Via the internet: 

w.horiba.com/scientific
o.sci@horiba.com 

In 
1-732-494-8660 × 268
1-732-549-5125 

In 
+33 (0) 1 64 54 13 00 
+33 (0) 1 69 09 93 19 

Wo :
  

y  
 

Japan +81 (0) 3 58230141 
UK +44 (0) 20 8204 8142 

a Software system information 

Description of the malfunction and the attempts, if any, to 
correct it. 
Note any error messages observed, and have any rel
spectra available with a
type, integration time, e

World-Wide Web ww
E-mail inf

North America: 
Telephone
Fax 

France: 
Telephone
Fax 

rldwide  
China +86 (0) 10 6849 2216
German +49 (0) 89 462317-15
Italy +39 (0) 2 57603050 
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Key to the entries: 
Times Roman 
font 

subject or 
keyword 

Arial font command, menu 
choice, or data-
entry field 

Arial 
Condensed 
Bold font 

window 

Courier 
New font 

file name or 
expression 

. 

... button ...................................... 40 

.SPC file .................................... 38 

= 

=> button .................................... 49 

< 

<< button .............................. 27, 31 

> 

>> button ......................... 23, 29, 32 

↑ 

↑ button ....................................... 49 

↓ 

↓ button ....................................... 49 

1 

1000M Series II ............................ 1 
1250M Series II ............................ 1 

3 

3D Scan to 3D Profile button... 38 

A 

About SynerJY window ......... 62, 63 
About SynerJY... ...................... 62 
Accessories tab .......................... 34 
accessory ........................ 20, 31, 34 
Accessory information ............. 20 
Accessory Information ............. 31 
Add button .................................. 31 
Add or Remove Programs ...... 57 
Add or Remove Programs window

 ............................................... 57 
Append ...................................... 46 
Apply button ............................... 32 
array detectors .............................. 1 
Auto Run Previous Experiment 

button ..................................... 38 
Autorun ................................ 4, 7, 8 
Available Data column ............. 48 
Available Devices .............. 29, 32 
Available Devices list ............... 23 
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B 

Browse button ...................... 40, 46 

C 

cables .................................. 2, 4, 41 
Cancel button ................. 21, 44, 55 
CCD .............................................. 2 
CCD-3000 ..................................... 1 
CCD-3500 ..................................... 1 
CCD Table Path ................. 20, 31 
CCD3000 ................................... 33 
CD-ROM drive ................. 1, 4, 5, 7 
Change button ........................... 10 
Change or Remove Programs 

icon ......................................... 57 
Choose Destination Location 

area ........................................... 9 
Clear button.................... 26, 28, 30 
Close button ............................... 55 
Collect .... 25, 27, 29, 36, 39, 41, 60 
combining two plots .................... 48 
Communications Parameters 19, 

31 
Company Name .......................... 9 
ConfigID ..................................... 22 
Configuration text box ............... 32 
Congratulations! You are 

finished installing your HJY 
USB device. area .................. 13 

contact information ..................... 64 
Continue Anyway button .......... 12 
Control Panel ............................ 56 
CP Series ....................................... 1 
Create button ................. 26, 28, 30 
Current radio button ................... 33 
Customer Information area ........ 9 

D 

Data Acquisition ........................ 61 
data folder ................................ 47 
DataScan ................................... 33 
DataScan2 ..................................... 1 

Detailed Component 
Configuration radio button ... 18 

detectors 19, 21, 26, 28, 30, 31, 43, 
44 

Detectors tab ............................. 33 
Device Configuration window ... 18, 

21 
Device Display Name ........ 20, 31 
disclaimer ................................ iii, v 

E 

Edit button ................ 22, 25, 27, 29 
EG&G 7260 .................................. 1 
Emulate radio button ................. 42 
emulation mode .......................... 41 
excitation-emission matrix ......... 38 
Exit ............................................. 55 
Experiment File field ................ 40 
Experiment Setup . 25, 27, 29, 36, 

39, 41 
Experiment Setup window .. 37, 39, 

42, 43, 44, 46, 55 
Extract to Layers button ........... 51 

F 

FHR1000 ...................................... 1 
FHR640 ........................................ 1 
File ................................. 52, 53, 54 
File menu .................. 52, 53, 54, 55 
File name field .......................... 54 
Filter Wheel ............................... 34 
Filter Wheel Information .... 20, 31 
filter-wheels .................................. 1 
Finish button .............. 5, 13, 14, 21 
FluorEssence window ................ 52 

G 

Gemini .......................................... 1 
GPIB = 6 checkbox ................... 33 
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H 

H10 ............................................... 1 
H20 ............................................... 1 
hard-disk space ............................. 1 
hardware configuration .. 15, 16, 17, 

22, 23, 25, 27, 29, 32, 37, 38, 39 
Hardware Configuration window

 ................................... 36, 39, 41 
help files ................................ 61, 62 
Help menu ............................ 61, 62 
HJY Application Software 3.0 . 58 
HJY USB ................................... 33 
Horiba Jobin Yvon USB Installer 

window ............................. 11, 13 
host computer ... 1, 7, 14, 21, 41, 57, 

58, 59 
HR Link Controller ....................... 1 
HR460 ........................................... 1 
HR640 ........................................... 1 

I 

I accept the terms of the license 
agreement radio button .......... 9 

I accept this EULA radio button 12 
IGA3000 ..................................... 33 
IGA-3000 ...................................... 1 
iHR320 .......................................... 1 
iHR550 .......................................... 1 
InGaAs Array ................................ 2 
Install button ............................... 10 
installation ....................... 1, 2, 4, 14 
Installed Components window ... 63 
Installing the software for your 

HJY USB device... area ....... 12 
InstallShield Wizard Complete 

area ......................................... 13 
InstallShield Wizard window ........ 4 
InstallShield® Wizard ................... 8 
Intermediate Display .................. 52 
IP Address ................................... 5 

J 

Jobin Yvon .......................... 35, 39 

L 

Layer Contents column ............ 49 
Layer Contents... ...................... 48 
Layer Number window ......... 48, 49 
Layout ............................ 26, 28, 30 
License Agreement .......... 4, 8, 11 
License Agreement area ...... 4, 11 
lock-in amplifiers ......................... 1 
Lockin ........................................ 33 

M 

M Series ........................................ 1 
Make Overlay File button ......... 38 
Merge button ............................. 50 
merging two or more graph 

windows ................................. 50 
monochromators ... 3, 14, 20, 31, 44 
Monos tab .................................. 33 
multi-channel detector .......... 20, 31 
My Computer icon ...................... 7 
My Computer window .................. 7 

N 

Network Interface Card (NIC) 
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